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Mentions légales
La marque Schneider Electric et toutes les marques de commerce de Schneider
Electric SE et de ses filiales mentionnées dans ce guide sont la propriété de
Schneider Electric SE ou de ses filiales. Toutes les autres marques peuvent être des
marques de commerce de leurs propriétaires respectifs. Ce guide et son contenu
sont protégés par les lois sur la propriété intellectuelle applicables et sont fournis à
titre d'information uniquement. Aucune partie de ce guide ne peut être reproduite ou
transmise sous quelque forme ou par quelque moyen que ce soit (électronique,
mécanique, photocopie, enregistrement ou autre), à quelque fin que ce soit, sans
l'autorisation écrite préalable de Schneider Electric.

Schneider Electric n'accorde aucun droit ni aucune licence d'utilisation commerciale
de ce guide ou de son contenu, sauf dans le cadre d'une licence non exclusive et
personnelle, pour le consulter tel quel.

Les produits et équipements Schneider Electric doivent être installés, utilisés et
entretenus uniquement par le personnel qualifié.

Les normes, spécifications et conceptions sont susceptibles d'être modifiées à tout
moment. Les informations contenues dans ce guide peuvent faire l'objet de
modifications sans préavis.

Dans la mesure permise par la loi applicable, Schneider Electric et ses filiales
déclinent toute responsabilité en cas d'erreurs ou d'omissions dans le contenu
informatif du présent document ou pour toute conséquence résultant de l'utilisation
des informations qu'il contient.
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Informations de sécurité

Informations importantes
Lisez attentivement ces directives et examinez l’appareillage pour vous
familiariser avec son fonctionnement avant de faire son installation ou son
entretien. Les messages spéciaux qui suivent peuvent apparaître dans ce
document ou sur l’appareillage. Ils vous avertissent de dangers potentiels ou
attirent votre attention sur des renseignements pouvant éclaircir ou simplifier une
procédure.

Veuillez noter

Seul du personnel qualifié doit se charger de l’installation, de l’utilisation, de
l’entretien et de la maintenance du matériel électrique. Schneider Electric décline
toute responsabilité quant aux conséquences éventuelles de l’utilisation de cette
documentation.

Une personne qualifiée est une personne disposant de compétences et de
connaissances dans le domaine de la construction, de l’installation et du
fonctionnement des équipements électriques, et ayant bénéficié d’une formation
de sécurité afin de reconnaître et d’éviter les risques encourus.

La présence de ce symbole sur une étiquette “Danger” ou “Avertissement” signale un 
risque d'électrocution qui provoquera des blessures physiques en cas de non-respect 
des consignes de sécurité.

Ce symbole est le symbole d'alerte de sécurité. Il vous avertit d'un risque de blessures 
corporelles. Respectez scrupuleusement les consignes de sécurité associées à ce 
symbole pour éviter de vous blesser ou de mettre votre vie en danger.

DANGER signale un risque qui, en cas de non-respect des consignes de sécurité, provoque 
la mort ou des blessures graves.

! DANGER

AVERTISSEMENT signale un risque qui, en cas de non-respect des consignes de sécurité, 
peut provoquer la mort ou des blessures graves.

AVERTISSEMENT    !

ATTENTION signale un risque qui, en cas de non-respect des consignes de sécurité, peut 
provoquer des blessures légères ou moyennement graves.

ATTENTION!

AVIS indique des pratiques n'entraînant pas de risques corporels.

AVIS
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Au sujet de ce guide

Champ d’application
Ce document décrit la procédure à suivre dans le logiciel EcoStruxure™ Control
Expert Classic pour créer un projet avec un TeSys™ island et un contrôleur
logique / contrôleur de mouvement utilisant le protocole Modbus TCP.

Ce document décrit également les procédures suivantes :
• Intégrer TeSys island au projet EcoStruxure Control Expert Classic.
• Accéder à l’outil DTM (Device Type Manager) TeSys island via le logiciel

EcoStruxure Control Expert Classic pour configurer les modules et processus
TeSys island à l’aide d’avatars TeSys.

• Utiliser les blocs fonctionnels de la bibliothèque TeSys island disponible dans
le logiciel EcoStruxure Control Expert Classic pour développer des
applications et contrôler les modules d’avatar TeSys.

L’utilisation de ce document doit être réservée aux utilisateurs justifiant des
connaissances suivantes :

• Fonctionnalité, structure et configuration de l’interface utilisateur TeSys island
• Fonctionnalité, structure et configuration du contrôleur

Remarque sur la validité
Ce guide est uniquement valable pour :

• Logiciel EcoStruxure Control Expert Classic v15.0 SP1 – Classic
• Automate Modicon M580

Informations en ligne
Les informations contenues dans ce guide sont susceptibles d’être mises à jour à
tout moment. Schneider Electric vous recommande fortement de consulter la
version la plus récente disponible sur www.se.com/ww/en/download/.

Les caractéristiques techniques des appareils décrits dans le présent document
sont également disponibles en ligne. Pour accéder aux informations en ligne,
rendez-vous sur la page d’accueil Schneider Electric.

Documents associés

Titre du document Numéro de référence
Guide du système TeSys island 8536IB1901FR

Aide en ligne de la bibliothèque DTM de TeSys island Disponible avec l’installateur

Manuel de référence du matériel Modicon M580 EIO0000001578

Guide de l’utilisateur EcoStruxure Control Expert – Contrôle des
bibliothèques TeSys island

EIO0000004519
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Terminologie issue des normes
Les termes techniques, la terminologie, les symboles et les descriptions qui
apparaissent dans ce manuel, ou dans ou sur les produits eux-mêmes, sont
généralement dérivés des termes ou des définitions figurant dans des normes
internationales.

Dans le domaine des systèmes de sécurité fonctionnelle, des entraînements et de
l’automatisme général, cela peut notamment inclure des termes tels que :
sécurité, fonction de sécurité, état de sécurité, défaut, réinitialisation de défaut,
dysfonctionnement, défaillance, erreur, message d’erreur, dangereux, etc.

Les normes incluses sont les suivantes :

Standard Description

CEI 61131-2:2007 Automates programmables, partie 2 : spécifications et essais des équipements

ISO 13849-1:2015 Sécurité des machines – Parties des systèmes de commande relatives à la
sécurité –

Principes généraux de conception

EN 61496-1:2013 Sécurité des machines – Équipements de protection électro-sensibles –

Partie 1 : prescriptions générales et essais

ISO 12100:2010 Sécurité des machines – Principes généraux de conception – Appréciation du risque
et réduction du risque

EN 60204-1:2006 Sécurité des machines – Équipement électrique des machines – Partie 1 :
Exigences générales

ISO 14119:2013 Sécurité des machines – Dispositifs de verrouillage associés à des protecteurs –
Principes de conception et de choix

ISO 13850:2015 Sécurité des machines – Fonction d’arrêt d’urgence – Principes de conception

CEI 62061:2015 Sécurité des machines – Sécurité fonctionnelle des systèmes électriques,
électroniques et électroniques programmables relatifs à la sécurité

CEI 61508-1:2010 Sécurité fonctionnelle des systèmes électriques, électroniques et électroniques
programmables relatifs à la sécurité – Exigences générales

CEI 61508-2:2010 Sécurité fonctionnelle des systèmes électriques, électroniques et électroniques
programmables relatifs à la sécurité – Exigences pour les systèmes électriques/
électroniques/électroniques programmables relatifs à la sécurité

CEI 61508-3:2010 Sécurité fonctionnelle des systèmes électriques, électroniques et électroniques
programmables relatifs à la sécurité – Exigences concernant les logiciels

CEI 61784-3:2016 Réseaux de communication industriels – Profils – Partie 3 : Bus de terrain de
sécurité fonctionnelle – Règles générales et définitions de profils

2006/42/CE Directive Machines

2014/30/UE Directive sur la compatibilité électromagnétique

2014/35/UE Directive basse tension

Les termes utilisés dans le présent document peuvent également être dérivés
d’autres normes telles que :

Standard Description

Série CEI 60034 Machines électriques tournantes

Série CEI 61800 Entraînements électriques de puissance à vitesse variable

Série CEI 61158 Communications numériques pour les systèmes de mesure et de commande – Bus
de terrain utilisés dans les systèmes de commande industriels
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Enfin, le terme de « zone de fonctionnement », susceptible d’être utilisé
conjointement avec la description de dangers spécifiques, doit s’entendre dans le
même sens que « zone de danger » ou « zone de risque », tel qu’employés dans
la directive Machines (2006/42/CE) et dans la norme ISO 12100:2010.

NOTE: Les normes susmentionnées ne s’appliquent pas nécessairement à
tous les produits mentionnés dans la présente documentation. Pour plus
d’informations concernant les normes individuellement applicables aux
produits décrits dans le présent document, reportez-vous aux tableaux des
caractéristiques des produits en question.

Informations concernant le produit

AVERTISSEMENT
PERTE DE CONTRÔLE
• Le concepteur d’un système de commande doit toujours prendre en compte

les modes de défaillance potentiels des voies de commande et, pour
certaines fonctions de commande critiques, fournir un moyen d’atteindre un
état sûr pendant et après une défaillance de la voie en question. Les
fonctions de commande critique sont par exemple l’arrêt d’urgence, l’arrêt en
cas de surcourse, la coupure de courant et le redémarrage.

• Des voies de commande séparées ou redondantes doivent être prévues
pour les fonctions de commande critiques.

• Les voies de commande du système peuvent comprendre des liaisons de
communication. Tenez compte des conséquences de possibles retards dans
la transmission ou défaillances de la liaison de communication.

• Respectez toutes les réglementations de prévention des accidents et les
directives de sécurité locales.1

• Chaque implémentation de cet équipement doit être individuellement et
rigoureusement testée quant à son bon fonctionnement avant toute mise en
service.

Le non-respect de ces instructions peut provoquer la mort, des blessures
graves ou des dommages matériels.

AVERTISSEMENT
RISQUE DE FONCTIONNEMENT INATTENDU
• N’utilisez que des logiciels agréés par Schneider Electric pour l’utilisation

avec cet équipement.
• Mettez à jour votre programme d’application chaque fois que vous modifiez

la configuration matérielle physique.
Le non-respect de ces instructions peut provoquer la mort, des blessures
graves ou des dommages matériels.

8 DOCA0236FR-00
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Avant de commencer
N’utilisez pas ce produit sur des machines qui n’offrent pas de protections
adéquates du poste de travail. L’absence de protections adéquates du poste de
travail d’une machine peut entraîner des blessures graves pour l’opérateur.

AVERTISSEMENT
ÉQUIPEMENTS NON SURVEILLÉS
• N’utilisez pas ce logiciel ni l’équipement d’automatisation associé sur des

équipements d’emballage qui n’offrent pas de protection adéquate du poste
de travail.

• Vous ne devez jamais vous pencher ni mettre la main à l’intérieur d’une
machine en fonctionnement.

Le non-respect de ces instructions peut provoquer la mort, des blessures
graves ou des dommages matériels.

Cet équipement d’automatisation et le logiciel associé servent à contrôler
différents procédés industriels. Le type ou le modèle d’équipement
d’automatisation adapté à chaque application varie suivant des facteurs tels que
la fonction de commande requise, le degré de protection requis, les méthodes de
production, les éventuelles conditions inhabituelles, les réglementations
applicables, etc. Certaines applications peuvent exiger plusieurs processeurs, par
exemple lorsqu’une redondance est nécessaire à des fins de sauvegarde.

Seul l’utilisateur peut connaître toutes les conditions et tous les facteurs présents
lors de l’installation, de l’utilisation et de l’entretien de la machine. Par conséquent,
seul l’utilisateur peut déterminer quels sont les équipements d’automatisation et
les protections et interverrouillages adaptés. Au moment de choisir l’équipement
d’automatisation et de commande et le logiciel associé pour une application
particulière, l’utilisateur doit se reporter aux normes et réglementations nationales
et européennes en vigueur. Des documents tels que le « Accident Prevention
Manual » (Guide pour éviter les accidents) du National Safety Council des États-
Unis contiennent également de nombreuses informations utiles.

En outre, dans certaines applications, par exemple dans le cas des machines
d’emballage, des protections supplémentaires du poste de travail de l’opérateur
doivent être mises en place. Il s’agit notamment d’empêcher que les mains ou
d’autres parties du corps de l’opérateur ne puissent librement accéder aux points
de pincement, sous peine de blessure grave. Aucun produit logiciel ne peut suffire
pour protéger un opérateur des blessures. Le logiciel ne saurait donc se substituer
à la mise en place de protections adéquates du poste de travail.

Avant de mettre l’équipement en service, assurez-vous que les sécurités et
interverrouillages liés aux protections du poste de travail ont été installés et qu’ils
sont opérationnels. Toutes les sécurités et tous les interverrouillages liés aux
protections du poste de travail doivent être coordonnés avec l’équipement
d’automatisation et la programmation du logiciel.

NOTE: La coordination des sécurités et des interverrouillages mécaniques et
électriques pour la protection du poste de travail sortent du cadre de la
bibliothèque des blocs de fonction, du manuel de l’utilisateur du système et de
toute autre implémentation référencée dans la présente documentation.

DOCA0236FR-00 9
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Démarrage et test
Après l’installation et avant l’utilisation régulière d’un équipement de commande et
d’automatisation électrique, un technicien qualifié doit impérativement procéder à
un test de démarrage pour s’assurer du bon fonctionnement de l’équipement. Ce
contrôle préalable doit être organisé en amont avec tout le temps nécessaire pour
être mené à bien de façon approfondie.

AVERTISSEMENT
DANGER LIÉ AU FONCTIONNEMENT DE L’ÉQUIPEMENT
• Vérifiez que toutes les procédures d’installation et de mise en service ont été

respectées.
• Avant de procéder aux tests de fonctionnement, retirez toutes les cales et

autres supports temporaires employés pour l’expédition des différents
composants matériels.

• Retirez de l’équipement les outils, les instruments de mesure et les débris.
Le non-respect de ces instructions peut provoquer la mort, des blessures
graves ou des dommages matériels.

Procédez aux tests de démarrage recommandés dans la documentation de
l’équipement. Rangez toute la documentation de l’équipement pour référence
ultérieure.

Les tests logiciels doivent être effectués en simulation mais aussi en
conditions réelles de production.

Assurez-vous que le système au complet est exempt de courts-circuits et de
mises à la terre non conformes aux normes et réglementations électriques
nationales (telles que le National Electrical Code aux États-Unis, par exemple) et
européennes. Si vous devez effectuer des tests à tension à potentiel élevé, suivez
les recommandations de la documentation de l’équipement pour éviter
d’endommager l’équipement.

Avant de mettre l’équipement sous tension :
• Retirez de l’équipement les outils, les instruments de mesure et les débris.
• Fermez la porte de l’armoire de l’équipement.
• Retirez toutes les lignes d’alimentation entrantes.
• Effectuez tous les tests de démarrage recommandés par le fabricant.

Utilisation et réglages
Les précautions suivantes sont tirées du site NEMA Standards Publication ICS
7.1-1995 (la version anglaise prévalant) :

• Malgré tout le soin apporté à la conception et à la fabrication de l’équipement
ainsi qu’à la sélection des catégories de composants, toute utilisation
incorrecte de l’équipement risque de créer des dangers.

• Il existe un risque de mauvais réglage de l’équipement susceptible de
provoquer un fonctionnement insatisfaisant, voire dangereux. Reportez-vous
toujours aux réglages fonctionnels recommandés dans les instructions du
fabricant. Le personnel qui a accès à ces réglages doit avoir pris
connaissance des instructions du fabricant de l’équipement ainsi que des
machines utilisées avec l’équipement électrique.

• L’opérateur ne doit avoir accès qu’aux réglages effectivement nécessaires à
son travail. L’accès à tous les autres contrôles doit être restreint afin
d’empêcher toute modification non autorisée des caractéristiques de
fonctionnement.

10 DOCA0236FR-00
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Introduction à TeSys island

Gamme principale TeSys
TeSys est une solution innovante de contrôle et de gestion des moteurs conçue
par le leader mondial du marché. Elle propose des produits et des solutions
connectés et efficaces pour la commande et la protection des moteurs et des
charges électriques, conformément aux principales normes électriques
mondiales.

Présentation
TeSys island fournit un système connecté et personnalisé pour la commande et la
gestion directes des charges basse tension. L’island optimise la disponibilité des
modules physiques avec des capacités intégrées de gestion de pré-alarme.

TeSys island est destiné aux machines de performance et de haute performance
avec des architectures d’automatisme basées sur des réseaux à haut débit
connectant des équipements à un automate. Les machines fonctionnant à des
cadences de production élevées doivent éviter les arrêts de production non
planifiés, qui peuvent être extrêmement coûteux. TeSys island aide à réduire les
temps d’arrêt imprévus grâce à la maintenance prédictive, afin que les réparations
soient effectuées dans les fenêtres de maintenance planifiées.

TeSys island est totalement intégré à l’environnement de programmation des
automates à l’aide d’objets numériques. TeSys island fait partie intégrante de la
gamme EcoStruxure, qui combine des produits et packages logiciels en solutions
d’automatisme pour intégrateurs OEM et constructeurs de machines. Le système
prend également en charge l’intégration à des automates tiers.

DOCA0236FR-00 11
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Concept TeSys island
TeSys island décrit un système d’entrées/sorties distribuées ouvert et modulaire
comprenant différents modules montés sur un fond de panier sur rail DIN.

A Coupleur de bus

B Module d’entrée/sortie analogique

C Module d’entrée/sortie numérique

D Module d’interface de tension

E Démarreur standard

F Démarreur SIL (Niveau d’intégrité de sécurité)

G Module d’interface SIL

H Module d’interface d’alimentation

Chaque appareil TeSys island constitue un nœud sur un réseau de bus de terrain.
Le coupleur de bus est le module central de l’appareil. Le coupleur de bus assure
la communication interne avec les modules TeSys island au moyen de câbles
plats et la communication externe via le protocole Modbus TCP.

Pour plus d’informations, reportez-vous au Guide du système TeSys island.

Configuration requise
Les composants suivants sont nécessaires pour la communication via EtherNet/IP
ou Modbus TCP.

Composant Type et version

Logiciel EcoStruxure Control Expert Classic Classic V15.0 SP1

Version de la bibliothèque PSx DTM 3.14.54

Version Schneider_Electric_TeSys_island_DTM_Library 2.2.2 ou ultérieure

Contrôleur Contrôleur logique BMEP58••••

12 DOCA0236FR-00
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Intégrer TeSys island dans le projet EcoStruxure
Control Expert Classic

Créer un projet
NOTE: Avant de créer un nouveau projet, vous devez connaître le type de
modèle d’automate et le fond de panier de l’automate à intégrer dans le projet.

Procédez comme suit pour créer un projet :

Étape Action

1 Ouvrez le logiciel EcoStruxure Contol Expert Classic.

2 Cliquez sur File > New (Fichier > Nouveau).

Résultat : La liste des automates s’affiche.

3 Sélectionnez un automate Modicon M580 en fonction du matériel qui sera utilisé pour le projet.
1. Dans la fenêtre PLC (Automate), cliquez sur Modicon M580.
2. Dans la fenêtre Rack , développez Modicon M580 local drop (Emplacement local Modicon

M580) et sélectionnez un rack..
3. Cliquez sur OK.

Résultat :
a. Une fenêtre de commande de traitement apparaît. Patientez jusqu’à ce que le traitement

des fichiers de configuration soit terminé.
b. Lorsque le traitement des fichiers est terminé, la fenêtre Security enforcement

(Application de la sécurité) s’affiche.

DOCA0236FR-00 13
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Expert Classic

Étape Action

4 Pour gérer un mot de passe, effectuez l’une des étapes suivantes, selon le cas :
• Créez un nouveau mot de passe pour le projet et cliquez sur OK.
• Cliquez sur Cancel (Annuler) si le mot de passe n’est pas requis.
Résultat : La structure du projet est créée et affichée dans la fenêtre Project Browser
(Explorateur de projet).
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Étape Action

5 Double-cliquez sur le dossier Configuration dans la vue structurelle.

Résultat : La vue physique de la configuration de l’appareil s’affiche.

DOCA0236FR-00 15
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Expert Classic

Ajout de TeSys island au projet
Procédez comme suit pour ajouter TeSys island au projet :

Étape Action

1 Cliquez sur Tools > DTM Browser (Outils > Navigateur de DTM).

2 Cliquez avec le bouton droit de la souris sur le nom de l’unité centrale dans la fenêtre DTM
Browser (Navigateur de DTM) et sélectionnez ADD (Ajouter).

Résultat : La fenêtre ADD s’affiche.

3 Dans le menu déroulant de protocole, sélectionnez Modbus over TCP (Modbus sur TCP).

16 DOCA0236FR-00
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Étape Action

4 Sélectionnez l’appareil TeSys island et cliquez sur Add DTM (Ajouter DTM).

Résultat : La fenêtre des propriétés de l’appareil s’affiche.

5 Dans la fenêtre Properties of device (Propriétés de l’appareil), modifiez le nom de l’appareil si
nécessaire et cliquez sur OK.

DOCA0236FR-00 17
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Expert Classic

Configurer l’adresse IP de l’unité centrale
Procédez comme suit pour configurer l’adresse IP de l’unité centrale.

Étape Action

1 Double-cliquez sur le dossier Configuration dans la fenêtre Project Browser (Explorateur de
projet).

Résultat : La vue physique de la configuration de l’appareil s’affiche.

2 Double-cliquez sur les connecteurs de communication de l’automate dans la fenêtre PLC bus (Bus
de l’automate).

Résultat : La fenêtre des paramètres de communication de l’automate s’affiche.

3 Cliquez sur le menu Security et effectuez l’une des étapes suivantes, selon le cas :
• Cliquez sur Enforce Security (Appliquer la sécurité) pour activer ou désactiver les services.
• Cliquez sur Unlock Security (Déverrouiller la sécurité) pour activer tous les services.
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Étape Action

4 Cliquez sur le menu Configuration IP et définissez l’adresse IP de l’unité centrale en fonction du
réseau.

Remarque : IP address A (Adresse IP A) doit être différent de Main IP address (Adresse IP
principale).

5
Cliquez sur l’icône de validation ( ) dans la barre d’outils.

DOCA0236FR-00 19



TeSys island – Solution numérique de gestion des moteurs
Intégrer TeSys island dans le projet EcoStruxure Control

Expert Classic

Configurer l’adresse IP de TeSys island
Procédez comme suit pour configurer l’adresse IP de TeSys island :

Étape Action

1 Double-cliquez sur l’unité centrale dans la fenêtre DTM Browser (Navigateur de DTM).

Résultat : La fenêtre de configuration de l’appareil s’affiche.

2 Sélectionnez le menu TeSys island device > Address Setting (Appareil TeSys island > Réglage
de l’adresse) et configurez l’adresse IP du TeSys island.

3 Cliquez sur Appliquer.

4

Cliquez sur l’icône de création ( ) dans la barre d’outils.
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Transférer le projet TeSys island sur l’automate
Procédez comme suit pour transférer le projet TeSys island sur l’automate :

Étape Action

1 Établissez la connexion entre le PC et l’automate en effectuant l’une des étapes suivantes :
• Connectez-vous à l’automate en utilisant l’adresse IP.

• Connectez le câble USB (BMXXCAUSBH018) entre le PC et le panneau avant de l’automate
M580.

2
Cliquez sur l’icône de connexion ( ) dans la barre d’outils.
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Étape Action

3
Cliquez sur l’icône de téléchargement ( ) dans la barre d’outils.

Résultat : La fenêtre Transfer Project to PLC (Transférer le projet sur l’automate) s’affiche.

4 Cliquez sur Transfer.

Résultat : Le projet TeSys island est transféré sur l’automate.

5 Double-cliquez sur l’unité centrale dans la fenêtre DTM Browser (Navigateur de DTM).

Résultat : La fenêtre de communication s’affiche.

6 Sélectionnez Channel Properties > IPAddress Source (PC) (Propriétés du canal > Source
d’adresse IP [PC]), puis cliquez sur OK.

7 Cliquez avec le bouton droit de la souris sur le nom de l’unité centrale dans la fenêtre DTM Browser
(Navigateur de DTM) et sélectionnez Connect (Connecter).
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Étape Action

8 Cliquez avec le bouton droit de la souris sur le nom de l’appareil TeSys island dans la fenêtre DTM
Browser (Navigateur de DTM) et sélectionnez Connect (Connecter).

9 Effectuez l’une des étapes suivantes selon le cas pour configurer le site TeSys island :
• Si le TeSys island a déjà été configuré et que l’utilisateur ne souhaite pas charger une nouvelle

configuration, cliquez avec le bouton droit de la souris sur l’appareil TeSys island dans la fenêtre
DTM Browser (Navigateur de DTM) et sélectionnez Load data from device (Charger les
données de l’appareil).

• Si le TeSys island n’a pas encore été configuré et que l’utilisateur souhaite charger une nouvelle
configuration, effectuez l’une des opérations suivantes selon le cas :
◦ Double-cliquez sur l’appareil TeSys island dans la fenêtre DTM Browser (Navigateur de DTM)

et configurez l’appareil.

◦ Cliquez avec le bouton droit sur l’appareil TeSys island dans la fenêtre DTM Browser
(Navigateur de DTM), puis cliquez sur Device > Additional functions > Import > Import
TeSys island Configurator Format (Appareil > Fonctions supplémentaires > Importer >
Format d’importation de configurateur TeSys island) pour importer les fichiers de
configuration.
Résultat : La nouvelle configuration est importée dans le logiciel.

DOCA0236FR-00 23



TeSys island – Solution numérique de gestion des moteurs
Intégrer TeSys island dans le projet EcoStruxure Control

Expert Classic

Étape Action

10 Double-cliquez sur l’appareil TeSys island dans la fenêtre DTM Browser (Navigateur de DTM) et
sélectionnez Store data to device (Stocker les données sur l’appareil).
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Téléchargement du projet TeSys island vers l’automate par câble
Ethernet

Procédez comme suit pour télécharger le projet TeSys island vers l’automate via
un câble Ethernet :

Étape Action

1 Cliquez sur PLC > Set Address (Automate > Définir l’adresse).

Résultat : La fenêtre Set Address (Définir l’adresse) s’affiche.

2 Sélectionner l’adresse IP de l’automate. Sous l’option Media, sélectionnez TCPIP et cliquez sur
OK.

3
Cliquez sur l’icône de connexion ( ) dans la barre d’outils.

Résultat : TeSys island est intégré au projet et connecté à l’automate Modicon M580 avec le
logiciel EcoStruxure Control Expert Classic.
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Utiliser la bibliothèque TeSys island pour le
développement d’applications

Présentation
La bibliothèque TeSys island est ajoutée au Types Library Manager
(Gestionnaire de bibliothèque de types) dans le logiciel EcoStruxure Control
Expert Classic. Le gestionnaire de bibliothèque fournit les blocs fonctionnels pour
le développement d’applications et le contrôle des avatars TeSys.

Installer des blocs fonctionnels de la bibliothèque TeSys island
Procédez comme suit pour installer les blocs fonctionnels de la bibliothèque
TeSys island :

Étape Action

1 Téléchargez la dernière version du fichier EcoStruxure Control Expert 2021 – TeSys island Library.
zip depuis le site du Schneider Electric Industry End Users and SI Campus.

2 Décompressez le fichier zip sur le disque dur local.

3 Cliquez sur Démarrer > EcoStruxure Control Expert Classic > Types library update (Mise à jour
de la bibliothèque de types).

Résultat : La fenêtre Types library update (Mise à jour de la bibliothèque de types) s’affiche.

4 Cliquez sur le bouton Parcourir.

5 Naviguez jusqu’à l’emplacement du dossier zip décompressé, sélectionnez le fichier FAMILY.DSC,
puis cliquez sur Ouvrir.
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Étape Action

6 Cliquez sur Install family (Installer la famille).

Résultat : L’installation du fichier de bibliothèque commence.

7 Un message confirme l’installation réussie d’un fichier de famille. Cliquez sur OK.

8 Ouvrez le logiciel EcoStruxure Control Expert Classic. Cliquez sur Tools > Types Library
Manager (Outils > Gestionnaire de bibliothèque de types).

Résultat : TeSys island Library 2021 s’affiche avec la version Libset V15.0 ou ultérieure.
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Configurer les paramètres de projet
Procédez comme suit pour configurer les paramètres du projet :

Étape Action

1 Ouvrez le fichier .stu ou .xref généré dans le logiciel EcoStruxure Control Expert Classic.

2 Cliquez sur Tools > Project Settings (Outils > Paramètres du projet).

Résultat : La fenêtre Project Settings (Paramètres du projet) s’affiche.

3 Cliquez sur Variables et cochez la case Allow dynamic arrays (ANY_ARRAY_XXX) (Autoriser les
tableaux dynamiques) pour éviter l’erreur détectée E1208 usage of dynamic arrays is disabled
(E1208 – l’utilisation de tableaux dynamiques est désactivée) lors de la compilation du projet.

4 Décochez la case Force references initialization (Forcer l’initialisation des références).

5 Cliquez sur Languages > Common (Langues > Courant) et cochez la case Allow multi
assignment [a=b=c] {ST/LD} (Autoriser l’affectation multiple [a=b=c] {ST/LD}) pour éviter l’erreur
détectée E1203 usage of dynamic arrays is disabled (E1203 – l’utilisation de tableaux
dynamiques est désactivée) lors de la compilation du projet.
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Utiliser les blocs fonctionnels pour développer une application
Procédez comme suit pour utiliser le bloc fonctionnel afin de développer
l’application dans le logiciel EcoStruxure Control Expert Classic :

Étape Action

1 Dans la fenêtre Project Browser (Explorateur de projet), cliquez sur Programs > Tasks > MAST >
Logic (Programmes > Tâches > MAST > Logique).

2 Cliquez avec le bouton droit de la souris sur le dossier Logic (Logique) et sélectionnez New
Section (Nouvelle section).

Résultat : La fenêtre New Section (Nouvelle section) s’affiche.

3 Saisissez un nouveau nom pour le bloc fonctionnel. Sélectionnez le langage FBD et cliquez sur OK.

Résultat : La fenêtre de zone de configuration s’affiche.
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Étape Action

4 Cliquez avec le bouton droit de la souris sur la zone de configuration et sélectionnez FFB Input
Assistant (Assistant d’entrée FFB).

Résultat : La fenêtre Function Input Assistant (Assistant d’entrée de fonction) s’affiche.

5 Cliquez sur le bouton Parcourir situé à côté de l’écran Function Input Assistant (Assistant d’entrée
de fonction).

Résultat : La fenêtre FFB Type Selection (Sélection du type FFB) s’affiche.

6 Dans l’écran FFB Type Selection (Sélection du type FFB), sélectionnez <Libset V15.0> > TeSys
island Library 2021 (Bibliothèque TeSys island 2021), puis sélectionnez le bloc fonctionnel requis
et cliquez sur OK.
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Étape Action

7 Après avoir sélectionné le bloc fonctionnel, cliquez sur OK dans l’écran Function Input Assistant
(Assistant d’entrée de fonction).

Résultat : Une icône apparaît près de la flèche de la souris.

8 Cliquez avec le bouton gauche de la souris sur la zone de configuration.

Résultat : La vue structurelle du bloc fonctionnel s’affiche.

Pour plus d’informations sur les blocs fonctionnels disponibles et leur
configuration, reportez-vous au document EcoStruxure Control Expert – TeSys
island Library Control – User Guide (Guide de l’utilisateur EcoStruxure Control
Expert – Contrôle des bibliothèques TeSys island).
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